
Apparel Version 2.0

Sales Automation
Software

Using Pen On The Road



 

RuggedWare, Ltd.

 

1444 Wazee Street, Suite 210
Denver, Colorado 80202

(303) 436-1234

 

©

 

 Copyright 1994 RuggedWare, Ltd.

 

™

 

 All rights reserved.

RuggedWare

 

™

 

, Pen On The Road

 

™

 

, RoadLink

 

™

 

, The Expert 
Interface

 

™

 

, and 

 

Outfitters for the Mind

 

™

 

 are trademarks of 
RuggedWare, Ltd.

All other brand and product names mentioned in this user’s 
guide are the service marks, trademarks, or registered 
trademarks of their respective owners.



Using Pen On The Road i

Using
Pen

On The
Road

Contents

Welcome to Pen On The Road  iii

Leading-edge features  iv

1 Getting Started Quickly  1

Starting Pen On The Road  2
Main Menu  3
Exiting Pen On The Road  4

2 Using the Help System  5

Displaying help on a window  6
Displaying the help contents  7
Selecting help topics  8
Tips, notes, ideas, cautions, and important 

information  10
Returning to previous help windows  11
Browsing help topics  11
Searching for a help topic  12
Getting help on help  13
Printing a help topic  13
Exiting the help system  14

3 Learning the Basics  15

Using the pen  16
Feedback symbols  17
Menu bars  18
Buttons  19
List boxes  20
Writing areas  21
Display areas and line selection  24
Scroll bars  25
Default values  26
Warnings versus errors  26
Additional help with basics  27

4 Working with Pen On The Road  29

Working with orders  30
Communicating with the home office  36
Inquiring about customers and products  37

5 Working with Orders  39

Writing a new order  40
Using batch sizing to produce an order  42
Writing orders in a hurry  43



ii Contents

6 Communicating with the Home Office  45

Preparing for a communications session  46
Exchanging information now  47
Exchanging information later  48
Troubleshooting a failed session  49

7 Inquiring about Customers & Products  51

Viewing Customer Information  52
Viewing product information  53

Index  55



Using Pen On The Road iii

C O N T E N T S:

WELCOME TO
PEN ON THE
ROAD

1 Getting 
Started 
Quickly

2 Using the 
Help System

3 Learning the 
Basics

4 Working with 
Pen On The 
Road

5 Working with 
Orders

6 Communi- 
cating with 
the Home 
Office

7 Inquiring 
about
Customers
& Products

Index

Using
Pen

On The
Road

Welcome to Pen On The Road

Everyone loathes unnecessary paperwork. Especially
the time-consuming paperwork that keeps you from
being more productive during the day and night.
RuggedWare Ltd. designed the revolutionary Pen On
The Road system with powerful features, not only to
streamline the order-writing task, but also to lend a
strategic advantage to you as a sales professional.

Pen On The Road features pen-based systems with
state-of-the-art handwriting recognition. Pen-based
computers help non-typists overcome the fear of
working with computers. The pen is a natural
extension of what most sales reps do every day.
With a pen, you simply write on the screen to put
information into your computer.

Pen On The Road allows you to take orders from your
customers with ease, transmit them to the home
office, and track important information on a powerful
notebook computer. Pen On The Road sends
information to the home office with RoadLink,
RuggedWare’s interface system to guarantee quick
response between the company and field
representatives. RoadLink features intelligent order
verification through its proprietary Expert Interface to
eliminate problems.

RuggedWare’s mission is to make the professional
sales rep the most proficient individual in the sales
field today. With this sales automation system, sales
reps can accurately write orders, size them, print
them for the customer, and transmit them to the
company in minutes, avoiding sleepless nights and
huge overnight shipping charges.
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Leading-edge features
RuggedWare leverages today’s advanced tech-
nologies to empower you as a sales professional.
Below are just a few of the reasons you’ll be able to
work even more effectively with Pen On The Road.

Order Writing
■ Easy retrieval of existing orders

■ Fast duplication of orders

■ Bar-code scanning for quick, accurate entries

■ Flexibility to override vendor-provided data

■ Handwriting recognition to avoid keyboard-
phobia

■ Invalid style numbers automatically restricted

■ Sizing constraints made simple through
graphic layouts of scales and size-grids

■ Only manufactured sizes permitted to be
ordered

■ Automated tracking of desired units against
sized units

■ Flexibility in line-by-line ship windows

■ Powerful reporting tools enhancing customer
service

Communications
■ Portable modem and quick three-step

process for transmitting orders to the home
office

■ Automatic backup of all data 

■ Current vendor data maintained through
RoadLink

Product Inquiry
■ At-a-glance display of style descriptions,

pricing, and shipping information

■ Instant retrieval of inventory projections,
including status of future cuts

■ Quick viewing of a style’s size-scale, with an
exact layout of manufactured sizes

Customer Inquiry
■ Easy access to complete customer profiles

■ Up-to-date accounts-receivable balances
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1 Getting Started Quickly

This chapter tells you how to:

■ Start Pen On The Road

■ Work with the MAIN MENU

■ Go to other chapters in this guide

■ Exit Pen On The Road

Information in other chapters
To learn about Pen On The Road’s help system, go to
chapter 2, Using the Help System.

If you are not familiar with pen computing, go to
chapter 3, Learning the Basics.

To learn more about Pen On The Road’s functionality,
go to chapter 4, Working with Pen On The Road.

To work with orders, go to chapter 5.

To communicate with the home office using a
modem, go to chapter 6.

To inquire about customers or products, go to
chapter 7.

Attention symbols
This book uses these five symbols to call attention to
tips, notes, ideas, situations requiring caution, and
important information.

Tip        Note      Idea    Caution   Important
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Starting Pen On The Road
Before you start Pen On The Road, exit any other
application programs. This gives Pen On The Road
the computing horsepower it needs for optimal
performance.

To start Pen On The Road:

➤ Double-tap on the Pen On The Road 2.0 icon in 
the program group named Pen On The Road.

Pen On The Road then displays its MAIN MENU.
For more information, go to the next topic: Main
Menu.

Go slowly at first!
When working with new software, take your time.
Study each new screen as it’s presented. Pay
attention to the information displayed in the
banner area that runs across the top of most
windows.

Pen On The Road 2.0 icon
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Main Menu
The MAIN MENU window is where you begin each
work session after you start Pen On The Road. Like a
restaurant menu, the MAIN MENU provides you with a
selection of items.

Navigation buttons
Pen On The Road’s MAIN MENU

provides you with five navigation
buttons. Each navigation button takes
you to the area you need to work in.

■ Tap the Write Orders button
to work with an order. See
chapter 5.

■ Tap the Send Orders button
to link your pen computer, via
modem and phone lines, to
your home office. See chapter
6.

■ Tap the Print Orders button to
print a paper copy of your
order.

■ Tap the Customer Inquiry button to get
information about any of your customer
accounts. See chapter 7.

■ Tap the Product Inquiry button to get
information about any style. See chapter 7.

Menu-bar topics
Pen On The Road’s MAIN MENU also provides you
with two menu-bar topics: File and Help. For more
information, see “Menu bars” on page 18.

Finding your way
In general, buttons along the bottom edge of Pen
On The Road windows are navigational; they help
you steer your way through a series of tasks.
When you tap a navigation button, it takes you to
the window or area suggested by its label.

Navigation buttons

Menu-bar topics
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Exiting Pen On The Road
As a general rule, return to the MAIN MENU before
quitting work with Pen On The Road.

It's also a good idea to back up your orders by
copying them to diskette immediately after you exit
Pen On The Road. See the Windows for Pen
Computing documentation for help with copying
electronic files.

To exit Pen On The Road:

1 Be sure you’re at the MAIN MENU window.

2 Tap the File menu-bar topic to get
a pull-down menu. 

3 Tap Exit, the last item on the File
menu.

After a few moments, Pen On The
Road closes, saving your
complete orders for sending to
the vendor and your incomplete
orders for future sessions. In place
of Pen On The Road’s Main Menu,
you’ll see the Program Manager
on your Windows desktop (that is,
your screen).

Stopping work safely
Try not to exit Pen On The Road or lose power
while working in an order. If you’re in an order
and need to exit Pen On The Road, first tap the
Exit Order button and then the Main Menu button
at the bottom of the ORDER STATUS window.

Sleep mode saves time and battery power
Use your pen computer’s sleep-mode feature
when you want to leave your work session for a
while and return to it later. In sleep mode, your
computer stays on, but it uses minimal battery
power. To put the computer “to sleep,” simply
close the computer’s lid while in Pen On The Road
(but preferably not in an order). Return to where
you left the system by opening the computer’s lid.
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2 Using the Help System

This chapter explains how to use Pen On The Road’s
help system.

Using Pen On The Road and the help system work
together to help you learn Pen On The Road quickly
and take full advantage of its many time-saving
features.

Chapters 5-7 in this book explain how to use Pen On
The Road to perform typical sales activities such as
writing orders, communicating with the home office,
and inquiring about customers and products.

As you perform sales activities, Pen On The Road’s
help system provides detailed instructions for
specific tasks such as handling new customers,
writing styles for order lines, and checking the
inventory of available products.

Attention symbols
This book uses these five symbols to call attention to
tips, notes, ideas, situations requiring caution, and
important information.

Tip        Note      Idea    Caution   Important
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Displaying help on a window
Pen On The Road help is context-sensitive, that is,
the help system keeps track of the window you are at
and gives you help about that window.

For example, when you ask for help at the ORDER

HEADER window, the help system displays topics
containing information about order-heading tasks.
When you ask for help at the ORDER window, the help
system displays topics containing information about
order-line tasks.

To display help for a window:

1 Tap the Help menu-bar topic to
get a pull-down list of choices.

2 Tap On This Window to display
context-sensitive help about the
window.

The Pen On The Road Help
System window appears.

For example, the help topic
shown in the illustration appears
when you tap On This Window at
the ORDERS MENU window.

See “Selecting help topics” on
page 8 for more information
about help topics.

What to do if the help contents list appears
Sometimes when you tap the Help menu-bar
topic and then tap On This Window, the help
contents list appears instead of context-sensitive
help. When this happens, tap on the topic you
want to read about. For more information on
using the help contents list, see “Displaying the
help contents” on page 7.
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Displaying the help contents
Occasionally, you may want to learn about a help
topic that is not related to the window you are at.

The Pen On The Road help system lets you choose
any of its topics by displaying its contents list.

To display the contents of the help 
system:

1 Display a Pen On The Road help window by any
method.

For example, tap the Help menu-bar topic to get
a pull-down list of choices. Then tap On This
Window.

2 Tap the Contents button near the top left corner
of the help window.

The help system displays its contents list, which
resembles the table of contents in a book.

3 Tap on the topic you want to read about.

See “Selecting help topics” on page 8 for more
information about help topics.

Some help topics on the list are hidden
The Help contents list is too long to fit within the
help window. Use the scroll bar on the right side
of the window to display the hidden help topics.
For information about using scroll bars, see
page 25.
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Selecting help topics
In Pen On The Road’s help system, you tap on topics
to read about them.

Help topics you can tap on are always underlined
with either a solid or dotted line. The topics are gray
or green depending on whether your computer has a
monochrome or color display screen.

To select a help topic:

➤ Tap on any underlined help topic to display it.

The help system replaces the current help topic
with the new help topic.

For example, you have just displayed context-
sensitive help for the ORDERS MENU. (See “Displaying
help on a window” on page 6.)

After reading the ORDERS MENU help topic, you can
tap on any of the following help topics:

■ Working with orders

■ Producing a series of orders

■ Creating a new order

■ Selecting an existing order

■ Coping an order

■ Looking for an existing order

To display the Selecting an existing order help topic.
tap on it. The following help window appears.
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After reading the Selecting an existing order help
topic, you can tap on either of the following help
topics:

■ To use the list box

■ To search for an order

Some help topics won’t fit in the help window
Whenever possible, Pen On The Road’s help
system keeps topics short so they fit within the
help window. You tap on other topics for
additional instructions.

Instructions for some topics, however, are too
long to fit in the help window at one time. These
topics contain scroll bars for displaying the rest of
the instructions. For more information about using
scroll bars, see page 25.
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Tips, notes, ideas, cautions, and 
important information
Many help topics contain tips, notes, ideas, cautions,
or important information. The titles of these special
attention topics are underlined with a dotted line.
They are gray or green depending on whether your
computer has a monochrome or color display screen,
and they appear following the words “Tap this title”
within the help topic.

To read a special attention topic:

➤ To read about a tip, note, idea, caution, or
important information, tap on its title.

Pen On The Road displays its text in a pop-up
window.

For example, if you tap the title, Producing a
series of similar orders, in the ORDERS MENU help
topic, the pop-up window in the illustration
appears.

To close a pop-up window:

➤ Tap anywhere in the pop-up window to close it.

What to do if the help window disappears
If you tap on the Pen On The Road window
instead of the pop-up window, the help window
disappears behind the Pen On The Road window.
To continue using the help system, re-tap the
Help menu-bar topic and then tap On This
Window.
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Returning to previous help 
windows
When you are done reading about a help topic, you
can return to previous help windows.

For example, when you have read about selecting an
existing order, you can return to the ORDERS MENU

help window and select another topic such as
Looking for an existing order.

To return to a previous help window:

➤ Tap the Back button near the top of the help
window to return to the previous help window.

You can also use the History feature as explained
in Windows help.

Browsing help topics
If you want, you can browse through help topics.
Browsing help topics is similar to browsing through
the pages of a book.

To browse help topics:

➤ Tap the >> button to browse forward through the
help topics

—OR—

➤ Tap the << button to browse backwards through
the help topics.

Back button
Browse buttons
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Searching for a help topic
You can search for a specific topic in the help system.
This feature resembles the alphabetical index in a
book.

To search for a help topic:

1 While you are displaying a topic in the help
system, tap the Search button near the top of the
help window.

The Search window appears.

2 Type the word or words you are searching for, or
tap on one of the items on the list.

You can use the scroll bar to display other items
on the list. For more information about using
scroll bars, see page 25.

3 Tap the Show Topics button.

At the bottom of the help window, the help
system displays a list of all the topics related to
the word(s) you typed or the item you selected.

In the example on this page, the user has
selected the item “copying - style numbers” and
tapped the Show Topics button. The help system
has displayed the topic related to the item:
“Writing style numbers on order lines.”

4 To select a topic on the list, tap it and then tap
the Go To button. Or, double-tap on the topic.

The help system displays the help topic.

Search button

Search window
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Getting help on help
Pen On The Road help is based on the Microsoft
Windows help system. Microsoft provides help on
using its help system.

To get help on help:

1 While you are displaying a topic in Pen On The
Road’s help system, tap on the Help menu-bar
topic. Then tap on How To Use Help.

Windows help displays a list of help topics.

2 Tap on the topic you want to learn about.

Printing a help topic
The help system lets you print a help topic.

To print a help topic:

1 Make sure your printer is connected properly and
loaded with paper.

If necessary, tap the File menu-bar topic and then
tap Printer Setup to review information about
how your printer is set up.

2 While you are displaying a topic in the help
system, tap the File menu-bar topic. Then tap
Print Topic.

The help system prints one topic at a time. It doesn’t
allow you to print all the subtopics associated with a
help topic or any of the “special attention” pop-up
windows.
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Exiting the help system
When you are done reading help topics, exit the help
system and continue working with Pen On The Road.

To exit the help system:

➤ On the help system’s menu bar, tap the File topic
and then tap Exit.

The help window disappears, and Pen On The
Road returns you to the window you were at
when you displayed help.

Do not exit using Pen On The Road’s menu bar!
Always use the help system’s menu bar to exit the
help system. Do not use Pen On The Road’s menu
bar. If you tap the File topic on Pen On The Road’s
menu bar and then tap Exit, you will exit Pen On
The Road. If you are working on an order when
you exit Pen On The Road, you will lose all the
information you entered on that order.

A quick way to exit the help system
You can exit the help system by tapping anywhere
on the Pen On The Road window. Part of this
window remains displayed behind the help
window while you are using the help system. If
you exit the help system using this method, do
not tap the Pen On The Road window twice.

Do not tap

Tap this File topic.

this File topic.

You can also
tap on the
partially
hidden Pen
On The Road
window.
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3 Learning the Basics

This chapter explains basic information about how
Pen On The Road works. Before using Pen On The
Road, make sure you understand all the information
in the following topics:

■ Using the pen

■ Feedback symbols

■ Menu bars

■ Buttons

■ List boxes

■ Writing areas

■ Display areas and line selection

■ Scroll bars

■ Default values

■ Warnings versus errors

■ Additional help with basics

If you already know this basic information, go to
chapter 4, which provides an overview of Pen On
The Road’s functionality.

Attention symbols
This book uses these five symbols to call attention to
tips, notes, ideas, situations requiring caution, and
important information.

Tip        Note      Idea    Caution   Important



16 Using Pen On The Road

Using the pen
You’ll find that using your special pen, directly on the
computer’s screen, is a very natural way to work with
Pen On The Road. Simply tap or write in forms (called
windows). Microsoft Windows and Pen On The Road
recognize your pen movements and perform actions
in response to them.

Tapping
The table below explains how to “tap” and “double
tap” on the screen with your pen.

Don’t re-tap until your pen computer responds

When your pen computer performs heavy-duty
activities (like making complex computations or
searching through the database for information),
Pen On The Road may take a moment to respond
to your pen actions. Look for feedback symbols to
understand what’s happening, and always wait for
your pen computer to finish processing your
instructions. For more information about feedback
symbols, see page 17.

Be careful not to repeat any tapping. Unnecessary
taps may cause delays if the computer interprets
the taps as additional instructions and follows the
instructions.

Don’t use the pen’s button
Pen On The Road does not use the button on the
side of the pen. Avoid pressing it as you work.

Using the keyboard and mouse
You can also use your pen computer’s keyboard and
mouse (or TrackPoint stick) to work with Pen On The
Road.

Use the keyboard to type words and numbers in the
forms.

Use the mouse (or TrackPoint stick) to tap by pointing
at an object on the screen and clicking the left
mouse-button.

TAP Action: Press the pen tip against the screen 
and then lift the pen tip up.

Result: Tapping activates or deactivates a 
button, displays a “pop-up” list or “pull-
down” menu, or selects a value such as a 
name on a list.

Tip: Tap firmly once, then pull your pen 
away.

DOUBLE

TAP

Action: Tap the pen twice quickly against 
the screen, in the same spot.

Result: In Windows, double-tapping on the 
upper left corner of a secondary window 
closes it. Double-tapping the corner of a 
main window exits you from Pen On The 
Road altogether.

Tip: Make sure both taps are in the exact 
same location. If you have difficulty double-
tapping, adjust the double-tap area and 
speed in the pen section of the Windows 
Control Panel.
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Feedback symbols
As you work, Pen On The Road displays feedback
symbols to tell you what's happening. Look for these
symbols as you work, and wait for an arrow pointer,
pen pointer, or blinking cursor to appear before
continuing with the next step.

ARROW

POINTER

Shows the location of your mouse 
or pen.

PEN POINTER Appears at active writing areas (see 
page 21) so that you may use 
electronic ink. Data in inactive 
writing areas appear dimmed or 
“grayed out” and will not give you 
this pointer.

HOURGLASS Indicates your computer is busy 
processing your instructions. Be 
sure to wait until one of the other 
symbols appears before continuing

QUESTION

MARK

Indicates an unrecognized pen 
gesture or character. Once in a 
while, the Handwriting Recognizer 
may display a Confirm Writing 
message box, to which you must 
respond.

BLINKING

CURSOR

Appears at an active writing area or 
list box so you can enter data with 
your pen or keyboard.
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Menu bars
The menu bar at the top of each main window helps
you work with features relevant to the current task.
Each topic on the menu bar displays a pull-down list
of choices (called menu items). To work with menu
topics, tap directly on the word and then tap on the
menu item you want.

■ Use the File menu to set up the printer or to
exit Pen On The Road.

■ Use Settings to show or hide order totals and
style descriptions (after you’ve written at
least one order line).

■ When you're working in an order, you can use
Information to validate the order, recall
heading details, and view inventory data.

■ Use Help to get on-screen assistance with
Pen On The Road and information about
technical support and the current software
version.

To close a menu without choosing any of the items,
tap outside the menu in the background of the main
window.

Menus, beeps, and dialog boxes
If you hear a beep when you tap the menu bar,
Pen On The Road has probably presented you
with a dialog box—a small window, centered on
top of the main window.

You must respond to a dialog box before you can
continue working in the main window (which
includes selecting a topic on the menu bar).
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Buttons
Pen On The Road provides a variety of buttons that
perform actions, select options, or display
information:

■ Label buttons

■ Radio buttons

■ Check boxes

■ Arrow buttons

Label buttons
Label buttons are rectangular, and they usually have
a text label. Pen On The Road uses two kinds of label
buttons:

■ Action buttons

■ Navigation buttons

Tapping an action button performs an action such as
creating a new customer, canceling an order line, or
searching for a product style.

Tapping a navigation button takes you to another
window. For example, the Customer Inquiry button
displays the CUSTOMER INQUIRY window.

Radio buttons
Radio buttons let you choose
a single option from a set of
choices.

Pen On The Road darkens the radio button that is
“on.” To select a different option, tap in the circular
button. This turns the button on and the previously
selected button off automatically. In the example
above, the Units button is on, and the Dollars button
is off.

Check boxes
Check boxes work like radio
buttons, but you can select
more than one of the options
at a time. Tap a check box to
turn it on or off.

Pen On The Road puts an X in a check box while it is
on. In the example above, three check boxes are on
and one is off.

Arrow buttons
Arrow buttons appear at the right side of list boxes.
Tap the button to display a list of options you can
choose from.

For more information, see “List boxes” on page 20.
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List boxes
List boxes let you quickly put information into your
computer forms. You can add information to a typical
list box with just two taps.

To choose information in a list box:

1 Tap the arrow button.

A drop-down list holding any number of options
appears.

The example in the next column shows the drop-
down list that appears after you tap on the arrow
button on the Customer Number list box.

2 If the data you want appears on
the list, tap on it to select it.

Pen On The Road places the item
you select in the list box.

If the list holds more items that
can be displayed at one time, use
the scroll bars to look for the data
you need. For more information
about scroll bars, see page 25.

Closing a list without choosing an item
Tap the arrow button again, or tap in the
background area of the current window. The list
disappears without changing the contents of the
list box.

To type information in a list box:
If the data you want is not an item on the list, you can
enter the data using the keyboard.

1 Tap in the list box to get a blinking cursor.

2 Type your information.

3 Press the Enter key when you’ve finished typing.

List box

Drop-down list
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Writing areas
Writing areas are made up of a series of connected
squares, or letter guides. They resemble the boxes
on paper forms and work much the same way. You
fill in information, such as a name or number, with
“electronic ink” from your pen. 

Some writing areas (such as Style Number) let you
write numbers only, some (such as Ship Date) let you
write dates only, and some (such as Customer Dept.
and Line Remarks) let you write nearly any
combination of characters—letters, digits, and
punctuation.

Date boxes
Date boxes are a special type of writing area. They
display dates in the MM-DD-YY (month, day, year)
format. For example, October 25, 1994 appears as
10-25-94. You must write your dates in this format
for the system to accept them. Certain date boxes set
additional restrictions, according to your
manufacturer's business policies, and prompt you
with messages in small informational windows to
meet these requirements.

Required and optional writing areas
The background color of writing areas indicates
whether you are must enter information in them to
complete an order.

Required writing areas are white. You must put
information in a required writing area before
changing your order's status to Complete.

Optional writing areas are gray. You can leave an
optional writing area empty and still change the
order's status to Complete.

Inactive writing areas
Some writing areas are inactive. The data in inactive
writing areas are dimmed and “locked in” for that
window—you cannot write over the data.

Making writing areas easier to view
If both required and optional writing areas appear
to be the same color or if you are having trouble
reading the characters in dimmed writing areas,
you may need to do one or both of the following:

■ Adjust the brightness and contrast dials on
the lid of your computer.

■ Go to the Colors icon in the Program
Manager's Control Panel to correct your
system's display settings. (Call RuggedWare
technical support for assistance.)

Letter guides
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Pen controls
To use writing areas with letter guides, you should
understand the screen objects that appear in and
around them as you use your pen. All of these
objects, or pen controls, work with Pen On The Road
and the Microsoft Handwriting Recognizer to ensure
the right data goes in each letter guide.

To enter information with your pen:

➤ Begin writing the first character inside a letter
guide and continue writing the remaining
characters in the squares provided.

You must print text—the pen computer’s
Handwriting Recognizer does not recognize
cursive handwriting. Parts of characters you write
can go outside their boxes, but that can make it
harder for the computer to recognize your
writing.

Start writing characters inside letter guides
Always start a character inside a letter guide. You
can, however, finish the character outside the
letter guide’s boundaries.

Handwriting pattern recognition
Microsoft's Handwriting Recognizer uses pattern-
recognition technology to translate your
handwriting. For instance, if you quickly write “1 2
3 A”, the Recognizer may expect a series of digits
and translate your writing as “1 2 3 4." Therefore,
if you mix digits and letters (such as in Customer
P.O. codes), pause between the two different
character types to let the system translate them
separately.

Problems with handwriting recognition
If your pen computer isn't translating your writing
correctly, see the Windows for Pen Computing
2.0 user guide or on-screen help for assistance.

PEN-CURSOR

BUTTON

This button appears after you write in 
(or lightly tap the edge of) a letter 
guide. You can drag the button left or 
right to select text you want to change.

PEN-EDITING

BUTTON

This button appears after you select 
text by tapping or double-tapping in a 
non-empty letter guide. The pen-
editing button is accompanied by a list 
of alternative characters or words from 
which you may choose. Simply tap the 
item you want to replace the selected 
text.

PEN EDIT

MENU

Tap the pen-cursor button once, to see 
this drop-down menu of editing 
options.?Note that this menu may pop 
up in the center of your screen.

TIP: To make the menu disappear 
without choosing an option, tap in the 
background area outside the menu.



Writing areas 23

C O N T E N T S:

Welcome to 
Pen On The 
Road

1 Getting 
Started 
Quickly

2 Using the 
Help System

3 LEARNING
THE BASICS

4 Working with 
Pen On The 
Road

5 Working with 
Orders

6 Communi- 
cating with 
the Home 
Office

7 Inquiring 
about
Customers
& Products

Index

To edit a character:

➤ Write on top of the current character (letter, digit,
or punctuation), making sure you start inside the
letter guide. Or, tap the character and use the
pen-editing button, provided above selected
text.

You can’t edit dimmed writing areas
Dimmed characters in a writing area mean the
information is “locked in” for the current window.
For example, if you return to the ORDER HEADER

window for an existing order, the Order Date,
Ship Date, and Cancel Date writing areas are
dimmed. You can’t edit them.

A space is a character!
Letter guides can contain characters—including
spaces—or they can be empty and contain
nothing at all.

A completely blank letter guide contains a space.

A gray dot means a letter guide is empty.

To edit a word or number:

1 Select the word or number by double-tapping
inside any of its letter guides, or by dragging the
pen-cursor button, until the entire word or
number is highlighted.

2 Tap the pen-editing button or an option in the
word editing drop-down menu.

You can’t write characters in scanning mode
If you're unable to write characters at the ORDER

window, be sure you're not in scanning mode.
The button should read “Scanning is OFF”.

EmptySpace
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Display areas and line selection
Several windows in Pen On The Road include display
areas, which present multiple lines of information in
table format. A display area contains

■ A line-selection column

■ Scroll bars when necessary

■ Column and row labels that explain the
table’s contents

Selecting a line in a display area:

➤ Tap directly on a line in a display 
area to select it.

Selecting a line automatically de-
selects the previously active line.

The triangular current-line pointer
on the line-selection column to
the left of the display area tells
you what line is currently active.

The ORDER window shows a line
selection column for an order with
five lines.

The triangular line selection pointer
indicates that the second order line is
active.

Line selection column
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Scroll bars
When Pen On The Road must display more
information than it can fit in a window, display area,
or drop-down list, it provides you with scroll bars to
view the extra information.

Vertical scroll bars let you view information to the top
or bottom of the displayed information such as
additional items on a list.

Horizontal scroll bars let you view information to the
right or left of the displayed information such as
additional values for each item.

To view information that does not fit 
into a window, display area, or list:

➤ Drag the square scroll box along the scroll bar,
towards the information that is not displayed

-OR-

➤ Tap the scroll bar on either side of the scroll box
to display the information a portion at a time

-OR-

➤ Tap the scroll arrow at the end of the scroll bar
next to the information that is not displayed.

Left scroll arrow Scroll box Horizontal scroll bar Right scroll arrow 

Vertical
scroll bar
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Default values
Pen On The Road provides default values in many list
boxes and writing areas. A default value is
information that Pen On The Road automatically fills
in after you‘ve selected something on the computer.

An example of a default value is at the ORDER

HEADING window. Once you select a particular
customer for a new order, that customer’s preferred
carrier appears in the Ship Via writing area. The
exception to this rule is when your vendor’s database
does not contain information about a customer’s
preferences. In this case, if the vendor did not know
your customer always uses, say, United Parcel
Service, then a general default value would appear in
the writing area. Default values save you tremendous
time and effort in writing orders. In most cases, you
may change or “overwrite” these default values
when you feel they are wrong for the situation.

Warnings versus errors
As you work with orders, Pen On The Road brings
warnings and errors to your attention in small
message windows. You also get a list of any
unresolved errors and warning in the ORDER

VALIDATION window when you wrap up an order.

Warnings simply caution you against a particular
action or data entry. Warnings never prohibit you
from completing and sending your order to the
home office. 

Errors, on the other hand, do prohibit you from
completing and sending your order to the home
office. To transmit orders to the home office (via
RoadLink), they must have a status of “Complete—
Not Sent.” You can’t assign this status to an order
until you have fixed all errors.
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Additional help with basics
This section tells you where to get additional help
that explains how to use:

■ your pen computer

■ Microsoft Windows

■ DOS

Pen On The Road runs on a pen computer—a PC
notebook computer with a pen and a screen that
recognizes actions made with the pen. The pen
computer uses the Microsoft Windows for Pen
Computing software. Microsoft Window runs “on top
of” the Disk Operating System (DOS), which directs
the computer’s activities.

The Pen On The Road help system, the Quick Guide
reference card, and this user’s guide work together
to help you learn Pen On The Road quickly and to
take full advantage of its many time-saving features.

Occasionally, you may need additional information
about your pen computer and how it operates. For
example, you may want to learn how to save battery
power by putting your pen computer to “sleep”
without quitting Pen On The Road. Or you may want
to learn how to move a window to another position
on your display screen.

The following table tells you what resources to see
for help with your computer and operating systems.

To learn about: See:

Your pen computer

Example: how to put 
your pen computer to 
sleep.

■ ThinkPad pen 
computer notebook 
manual

■ Your printer or 
modem manual

Microsoft Windows

Example: how to move 
a window.

■ Windows for Pen 
Computing user’s 
guide

■ Microsoft Windows 
user’s guide

■ Windows for 
Dummies

DOS

Example: how to copy a 
file using a DOS 
command.

■ DOS command 
reference

■ PenDOS user’s 
guide

Other questions ■ RuggedWare 
Technical Support 
1-800-754-9992
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4 Working with Pen On The Road

This chapter presents an overview of Pen On The
Road’s three main functional areas:

■ Working with orders (chapter 5)

■ Communicating with the home office
(chapter 6)

■ Inquiring about customers and products
(chapter 7)

To access these functional areas, tap on the
navigation buttons at the MAIN MENU window. For
more information, see chapter 1, “Getting Started
Quickly” on page 1.

Because RuggedWare provides a customized Pen On
The Road system tailored to each client company’s
needs, the sample windows in this chapter may not
match the windows you see when you run Pen On
The Road.

Your version of Pen On The Road has been optimized
to store the information you need about your
customers and products and to support your
business policies and procedures.

Along with your customized Pen On The Road
system, you have a customized help system. It
provides detailed instructions for performing specific
tasks such as handling new customers, writing styles
for an order line, and checking the inventory of

available products for your customized Pen On The
Road system. For more information about using the
help system, see chapter 2 on page 5.

Although your Pen On The Road system is
customized, it shares basic functionality and many
features with other Pen On The Road systems. This
chapter describes Pen On The Road’s functionality
and highlights important features.

Attention symbols
This book uses these five symbols to call attention to
tips, notes, ideas, situations requiring caution, and
important information.

Tip        Note      Idea    Caution   Important
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Working with orders
Working with orders involves:

■ Creating, copying, or selecting an order

■ Filling in information that pertains to the
entire order

■ Writing order lines

■ Wrapping up the order by reviewing and
validating it, resolving any errors, and getting
the customer’s signature (if appropriate)

Reports, customized to your company’s needs,
appear with a tap of your pen to show how much a
customer has ordered by month, by category, etc.

Creating, copying, or 
selecting an order
Pen On The Road helps you get to the
orders you need, whether you’re
starting a new order, copying an
existing order to save time, or
hunting for an existing order.

A typical ORDER SEARCH window, such
as the one shown on this page, lets
you search for an order using
different criteria to narrow your
choices.

For example, you can choose to see only completed
orders for a customer, or you can retrieve a specific
order by providing a customer P.O. number.

After you select your criteria, Pen On The Road
displays a listing of all orders that meet your criteria.

Tap on the order you want, and Pen On The Road
displays it for you.

Pen On The Road keeps the listing of orders for you.
You can return to it and display other orders on the
list.
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Filling in information for an entire 
order
Filling in information for an entire order involves:

■ Choosing the appropriate customer and store

■ Working with billing and shipping details

■ Providing additional information, like Source
code and Customer P.O. number, and special
instructions

The sample window on this page shows order
information for a typical Pen On The Road system.
The information your company stores may vary
based on your company’s unique needs.

You can fill in the information easily by writing it with
your pen or selecting an option on a drop-down list.



32 Using Pen On The Road

Writing order lines
Writing order lines involves:

■ Writing styles

■ Checking inventory for styles

■ Setting total units

■ Sizing order lines

■ Selecting inventory cuts

■ Discounting order-line prices, if needed

■ Making any required changes to general
order information for specific order lines

■ Adding line remarks

The sizing and inventory features
show items available to sell in each
size, for each manufacturing date. As
you fill in sized units on the electronic
order-form, Pen On The Road’s
automatic totalling function does all
the calculating for you. Pen On The
Road handles override processing
instructions for individual order lines
with ease, too.

Thanks to the technology operating
behind the scenes, Pen On The Road
order-writing protects you from
entering invalid style numbers,
incorrect prices, and so on. Working
with Pen On The Road order-writing
also provides you a wealth of up-to-
date, strategic information. 

Style descriptions, inventory, and sizing—
a step-by-step example
This example shows how Pen On The Road lets you
specify a style description for an order line, check the
available inventory for that style, and then size the
order line.

The sample ORDER window on this page shows an
order with five lines. As with other sample windows,
the information your company stores for order lines
may vary based on your company’s unique needs.

1 After filling in styles and units for five lines, the
sales rep selects line 2, which orders 51 units of
style 1-01-101-030.
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2 The sales rep taps the Information topic on the
menu bar and then taps Inventory to display the
available inventory for style 1-01-101-030.

The INVENTORY FOR STYLE window appears on top
of the ORDER window.

3 Knowing that inventory is available, the sales rep
taps the Sizing button to display the sizing grid
for style 1-01-101-030.

Pen On The Road displays different sizing grids
for different styles. For style 1-01-101-030, the
sizing grid covers neck sizes from 14 to 18 and
sleeve sizes from 32 to 36.

4 Next, the sales rep taps the cut line for cut 48 in
the INVENTORY FOR STYLE window.

Pen On The Road displays the number of units
available in each size, specific to that cut.
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When multiple cuts are available, the sales rep
can tap different cuts in the INVENTORY FOR STYLE

window to find the best inventory and ship-date
combination for the customer.

5 The sales rep now fills in units for each size based
on the available inventory.

Pen On The Road automatically totals the units.
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Wrapping up the order
Wrapping up an order involves:

■ Reviewing it for accuracy

■ Working with Order Summary
reports

■ Validating the order to resolve
any errors or warnings

■ Changing the order’s status

■ Getting the customer’s
electronic signature (if
needed)

The SUMMARY window on the upper
right shows a typical example of the
reports you get with Pen On The
Road.

The window on the lower right shows
an ORDER VALIDATION dialog box with
two errors.
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Communicating with the home 
office
Tap the Send Orders button and Pen
On The Road is ready to send
completed orders to the home office.
Tap another button and the
completed orders are off. When
RoadLink receives your orders, it
automatically sends back the
company’s latest information—
everything that has changed since the
last time you sent in an order. The
two-way highway between sales rep
and home office is instant and
effortless.

The window on this page shows a
typical COMMUNICATIONS window with
communications instructions and
buttons for Dial Now and Dial Later.
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Inquiring about customers and 
products
Tap the Customer Inquiry button and Pen On The
Road supplies complete, up-to-date customer
information including: shipping and billing
addresses; receivables; and customer profiles and
preferences. Each company using Pen On The Road
specifies exactly how much customer information
they wish to display. Now you don’t have to call the
credit department to check on a customer—the
information is in your pen computer.

The window on this page shows customer
information.

Tap the Product Inquiry button to look up details of
any inventory item. Write in the style number and
product details pop up on your screen. Tap the
Inventory menu option and manufacturing dates
appear, allowing you to check product availability for
individual sizes. Again, these details are customized
to each company’s needs.
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5 Working with Orders

This chapter presents three activities that show
different ways of writing your orders with the Pen On
The Road system.

Each activity describes a typical path through order-
writing sessions.

■ Writing a new order

The most common way to write orders, for an
existing single-store account

■ Using batch sizing to produce an order

Another way to size your order, using the
Size Next button

■ Writing orders in a hurry

A fast and simple way to take an order from
your customer

For instructions on specific tasks, refer to the Pen On
The Road help system.

Updating your support data
If it’s been a while since your last data exchange
with RoadLink, update your pen computer’s
support data. See the Communications help
topics for more information. You can hold a
communications session with RoadLink at any
time. You don’t need to have completed orders.

Attention symbols
This book uses these five symbols to call attention to
tips, notes, ideas, situations requiring caution, and
important information.

Tip        Note      Idea    Caution   Important
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Writing a new order
Follow these basic steps to produce a new order.

For information about each step, use the Pen On The
Road help system. For more information, see
chapter 2, “Using the Help System,” on page 5.

To write a new order:

1 Tap the Write Orders button at MAIN MENU.

The ORDERS MENU appears.

2 Tap the Create New Order button.

The ORDER HEADING window appears.

3 Fill in general information about the order at the
ORDER HEADING, ADDRESSES, and SPECIAL

INSTRUCTIONS windows.

For instructions, see the following topics in the
ORDER HEADING help window:

■ Filling in order heading information

■ Handling new customers

■ Specifying new stores for existing customers

■ Showing or hiding running totals

■ Verifying billing and shipping addresses

■ Changing the shipping address for an order

■ Adding special instructions

4 Write each order line—including style number
and optional unit total and pricing—while paying
attention to inventory availability.

For instructions, see the following topics in the
ORDER LINES help window:

■ Order lines—Writing an order line

■ Order lines—Setting total units for an order
line

■ Order lines—Discounting an order-line price

■ Style numbers—Writing style numbers on
order lines

■ Style numbers—Recalling style descriptions

■ Scanning product bar codes

■ Inventory—Checking inventory for styles

5 Size each order line.

For instructions, see the following topics in the
ORDER LINES help window:

■ Sizing—Sizing units for an order line

■ Sizing—Sizing a pre-pack style

■ Inventory—Selecting inventory cuts in sizing
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6 If necessary, change the general order
information that Pen On The Road automatically
assigns to each order line. Add line remarks if
needed.

For instructions, see the following topics in the
ORDER LINES help window:

■ Line detail—Changing order information for
one line

■ Line detail—Adding line remarks

7 Optional: Review order totals in various reports,
making changes as necessary.

For instructions, see the following help topic:

■ Working with Order Summary reports

8 Exit the order to wrap it up.

9 Validate the order by fixing errors and
responding to warnings if necessary.

For instructions, see the following help topic:

■ Handling errors and warnings

10 Change order status to “Complete—Not Sent”
when it's finished.

For instructions, see the following help topic:

■ Changing your order's status

11 Request your customer's signature on the order,
after verifying contract terms.

For instructions, see the following help topic:

■ Getting the customer’s signature

12 Optional: Print a paper copy of the order.

For instructions, see the following help topic:

■ Printing an order

13 Optional: Write confidential special instructions
to the home office.

For instructions, see the following topic in the
ORDER HEADING help window:

■ Adding special instructions

14 Copy your order data onto a diskette to guard
against losing the electronic order.

15 Send the order to the home office electronically.

For instructions, see chapter 6, “Communicating
with the Home Office,” on page 45.

16 Check the order's processing status through
standard procedures.
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Using batch sizing to produce an 
order
Batch sizing uses the Size Next button in Sizing to
help you size a group or batch of written styles
quickly.

For information about each step, use the Pen On The
Road help system. For more information, see
chapter 2, “Using the Help System,” on page 5.

To produce an order with the batch 
sizing feature:

1 Begin writing a new order, adding at least three
or four unsized order lines.

2 For instructions, see “Writing a new order” on
page 40.

3 Go to the ORDER LINES window.

4 Select Order Line 1 in the order-lines display
area.

For instructions, see the following topic in the
ORDER LINES help window:

■ Order lines—Selecting individual order lines

5 Tap the Sizing button to display Line 1's size grid.

6 Perform sizing for that style number, using size-
specific inventory projections to guide your ship
date and quantities.

7 Tap the Size Next button.

The Sizing window changes to display the sizing
information for Line 2.

For instructions, see the following topic in the
ORDER LINES help window:

■ Sizing—Working with the Size Next feature

8 Perform sizing for Line 2.

9 Repeat steps 6 and 7 until Pen On The Road
informs you there are no more style numbers to
be sized.

10 Complete your order as explained in steps 6
through 16 of the Writing a New Order activity.

Batch Sizing helps you review your order
Use the Size Next button to quickly review a
written order's distribution of sizes. Simply follow
the instructions in this task, starting with step 2.
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Writing orders in a hurry
This activity shows you how to get the most crucial
data into your order quickly using Pen On The Road.
This fast, simple method of creating a new order
applies whenever you are rushed, or when you have
very little information to construct an order.

For information about each step, use the Pen On The
Road help system. For more information, see
chapter 2, “Using the Help System,” on page 5.

To create an order in a hurry:

1 Go to the Orders Menu window by tapping the
Write Orders button at MAIN MENU.

2 Tap the Create New Order button.

The ORDER HEADING window appears.

3 Fill in the Customer Number (and Store Number,
if multiple locations), and change the information
in the Ship Via list box if necessary.

For instructions, see the following topic in the
ORDER HEADING help window:

■ Filling in order heading information

4 Review addresses stored by the home office.

Change the addresses if necessary.

For instructions, see the following topics in the
ORDER HEADING help window:

■ Verifying billing and shipping addresses

■ Changing the shipping address for an order

5 Go to the ORDER LINES window.

6 Optional: From the Information menu, tap the
Inventory menu topic to show availabilities as
you work. 

For instructions, see the following topic in the
ORDER LINES help window:

■ Inventory—Checking inventory for styles

7 Write valid styles, and total units as necessary.

For instructions, see the following topics in the
ORDER LINES help window:

■ Order lines—Writing an order line

■ Order lines—Setting total units for an order
line

■ Order lines—Discounting an order-line price

■ Style numbers—Writing style numbers on
order lines

■ Style numbers—Recalling style descriptions

■ Scanning product bar codes
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8 Do sizing if needed, otherwise perform it later.

■ Sizing—Sizing units for an order line

■ Sizing—Sizing a pre-pack style

■ Inventory—Selecting inventory cuts in sizing

9 Add line detail if it is crucial to the order.

For instructions, see the following topics in the
ORDER LINES help window:

■ Line detail—Changing order information for
one line

■ Line detail—Adding line remarks

10 Tap the Exit Order button.

11 Tap the Validation button to handle any crucial
errors.

You can ignore most errors and warnings for now
since the order's status may be left as
“Incomplete.”

For instructions, see the following help topic:

■ Handling errors and warnings

12 Optional: Get the customer's signature.

For instructions, see the following help topic:

■ Getting the customer's signature

Now you can return to the MAIN MENU and begin
a new activity. Remember to complete this order
at a later time.

Preparing for appointments
Whether you are working at a customer site or at
a trade show, write as much of the order as you
can before your appointment. You can even leave
Pen On The Road in sleep mode until the
appointment.
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6 Communicating with the Home Office

This chapter explains how to exchange data with
your home office through an electronic
communications session with RoadLink.

A communications session with your home office has
three main goals:

■ To transmit your completed but unsent
orders to the home office for processing, via
RoadLink, the Expert Interface.

■ To update your pen computer with the
support data you need for accurate
information on available and withdrawn
styles, new customers, and so on.

■ To change the status of successfully-
transmitted orders to “Complete Sent” so
that these orders aren’t re-transmitted with
the next batch of orders you finish and send. 

RoadLink, The Expert Interface
Your pen computer must communicate frequently
with a system called RoadLink, a software module
on a computer at the home office. RoadLink takes
your completed, unsent-status orders and, at the
same time, updates your pen computer with
support data. Support data includes pricing, style
numbers and descriptions, customer information,
and so on.

Important
Read the section entitled “Preparing for a
communications session” on page 46 for a
checklist of general precautions to follow any time
you connect a modem to a phone line. 

Receiving support data
You can use the Send Orders feature to receive
the most current support data from your home
office. You don’t need to have any completed
orders to hold a communications session with
RoadLink.

Attention symbols
This book uses these five symbols to call attention to
tips, notes, ideas, situations requiring caution, and
important information.

Tip        Note      Idea    Caution   Important
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Preparing for a communications 
session
Here are some things to check whenever you
prepare for a communications session and hook up
your modem to a phone line.

■ Make sure all of the orders you want to send
have the status “Complete—Not Sent).”

■ Make sure your pen computer’s system clock
is set to the correct time of day.

■ Using the AC adapter, plug your pen
computer into an AC outlet, so you don’t lose
power during transmission.

■ Make sure you’ve plugged the modem cord
into the computer and the phone jack. All
connections should be tight and fitted
together properly.

■ Avoid using the pen computer within five
feet of a television or other large electronic
equipment.

■ Double-check your hotel’s prefix if a prefix is
required to dial out.

■ If the phone you’re using allows Call Waiting,
deactivate it before starting your
communications session. If you don’t, call-
waiting signals may cause your session to fail.

■ Allow at least 20 minutes for the call.

■ Always wait for the pen computer to finish
before disconnecting the modem.

■ If you get a busy signal, wait 15 minutes
before trying again.

■ If the pen computer is still unable to connect
with RoadLink, dial the number with the
phone to ensure the server is working. You
can tell the RoadLink server is ready if you
hear whistling sounds and tones, rather than
a busy signal. 

Disrupted communications sessions
If a communications session with RoadLink is
disrupted at any point, Pen On The Road
automatically redials (up to three times) and
completes the session.
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Exchanging information now
This task explains how to exchange information with
the home office immediately.

A communications session with RoadLink takes
approximately 15 minutes of dedicated phone time,
plus an additional half hour of processing on your
pen computer.

Better later than now?
If you want to have the pen computer begin the
session at a later time within the next 24 hours,
follow the instructions in “Exchanging information
later” on page 48.

To exchange information now:

1 From the MAIN MENU, tap Send Orders to get the
initial COMMUNICATIONS window.

Check your phone cord connections. If needed,
enter a dialing prefix in the blank writing area
provided. For prefix information, call your local or
hotel operator.

2 If you’re ready to let the pen computer handle
communications for the next 20 minutes or so,
tap the Dial Now button.

The COMMUNICATION STATUS window appears.

3 Watch the COMMUNICATION STATUS window as Pen
On The Road establishes its connection with
RoadLink and proceeds to exchange information
electronically.

You’ll hear a dial tone followed by whistling
modem sounds and beeps.

Pen On The Road informs you of the session’s
status as it performs each step. A “failed”
message means that you should troubleshoot the
problem by calling Pen On The Road’s technical
support or by reviewing the session log. See
“Troubleshooting a failed session” on page 49.

4 When the communications session finishes, Pen
On The Road prompts you to disconnect the
phone line.

5 Once your pen computer has processed the new
RoadLink data, you can quit the Send Orders task
by tapping the Main Menu button.

Order status changes automatically
Pen On The Road changes the order status of
successfully transmitted orders to “Complete—
Sent” at this time.
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Exchanging information later
This task helps you use Pen On The Road’s special
Dial Later feature. Dial Later lets you make your
modem connection to the home office when it is
most convenient for you. For example, you can use
the Dial Later feature to exchange information
overnight while you are sleeping.

1 From the MAIN MENU, tap Send Orders to get the
initial COMMUNICATIONS window.

Check your phone cord connections. If needed,
enter a dialing prefix in the blank writing area
provided. For prefix information, call your local or
hotel operator.

2 Tap the Dial Later button to get the Set Auto Dial
Time dialog box.

3 Write the hour (a number from 1 to 12, not
military time) and minutes (00-59) of the time
you want Pen On The Road to begin the
information exchange, in the writing areas
provided.

4 Tap either the AM or PM checkbox to indicate
your choice. Note that 12:00 PM is noon and
12:00 AM is midnight.

Make sure the pen computer translates your
handwriting correctly. Pen On The Road will tell
you what portion to correct if the time you’ve
specified is invalid.

5 Tap OK to accept the hour shown.

The Auto Dial Activated box appears and remains
on screen until the auto-dial time arrives.

Caution
Do not tap anything else until that time occurs and
your session is over. 

6 When Pen On The Road begins dialing, you may
continue with step 3 of “Exchanging information
now” on page 47, or you may leave the pen
computer unattended.

7 Check the pen computer at your convenience to
make sure the session was successful.

8 Once your pen computer has processed the new
RoadLink data, you can quit the Send Orders task
by tapping the Main Menu button.
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Troubleshooting a failed session
If your communications session fails, follow these
instructions.

See “Preparing for a communications session” on
page 46 for ways to ensure a successful session.

To troubleshoot a failed session:

1 Tap the Display Log button to get a recap of what
occurred during your last session.

You can also see Session Logs for successful
transmissions.

2 Read the log messages to see what happened,
and call Pen On The Road’s technical support if
needed.

3 Tap the Cancel Log button to close the SESSION

LOG display.

The Cancel Log button appears only when the
SESSION LOG window is on your screen.

Need help?
For help with communications problems, contact
RuggedWare technical support. See “Additional
help with basics” on page 27.
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7 Inquiring about Customers & Products

This chapter explains how to inquire about customer
and product information.

Customer Inquiry, available at MAIN MENU and at the
PRODUCT INQUIRY window, provides useful
information about your accounts:

■ Basic information such as addresses, 
contacts, and phone numbers

■ Billing and shipping information

■ Accounts receivable balances

Product Inquiry, available at MAIN MENU and at the
CUSTOMER INQUIRY windows, presents a variety of
information on vendor product styles:

■ Vendor information such as style
descriptions, pricing, shipping, and handling
details

■ Sizing information

■ Inventory information

Product Inquiry also provides access to the Style
Search feature.

Attention symbols
This book uses these five symbols to call attention to
tips, notes, ideas, situations requiring caution, and
important information.

Tip        Note      Idea    Caution   Important
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Viewing Customer Information
You can go to this window from either the MAIN

MENU or the PRODUCT INQUIRY window.

Customer information at the CUSTOMER INQUIRY

windows is view-only. You cannot change or delete
any of the data. 

While you are working with orders, however, you
can change shipping addresses for a particular order.
See Pen On The Road help for specific information
about changing the shipping address.

To view basic customer data:

1 Tap the Customer Inquiry button at MAIN MENU.

A CUSTOMER INQUIRY window without any
customer data appears. 

2 Choose a customer account from the Customer
Number list box.

Whatever basic account information the vendor
has stored for that customer and store appears in
the window.

For specific instructions on viewing basic customer
data, see the following topic in Pen On The Road
help:

■ Viewing basic customer data

To view additional customer data:

➤ Tap the Addl. Customer Info button at the
CUSTOMER INQUIRY I window.

The CUSTOMER INQUIRY II window appears with
billing, shipping, and accounts receivable
information for the current customer and store.

For specific instructions on viewing additional
customer data, see the following topic in Pen On The
Road help:

■ Viewing additional customer information
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Viewing product information
The PRODUCT INQUIRY window is like an electronic
swatch card—it provides basic information about a
particular vendor product.

You can go to this window from either the MAIN

MENU or the CUSTOMER INQUIRY windows.

You can also get a small recap of style information as
you write orders.

All PRODUCT INQUIRY information is view-only. You
cannot change or delete any of the data.

To view vendor product information:
When you write a valid style number in the Style
writing area, vendor product information
automatically appears in the window, including:

■ style descriptions

■ pricing

■ shipping information

■ handling details

For instructions on viewing vendor product
information, see the following topic in Pen On The
Road help:

■ To view basic product (style) information

To view sizing information:
After getting a style’s basic data in the PRODUCT

INQUIRY window, perform this task to check what
sizing the vendor permits.

For specific instructions on viewing sizing
information, see the following topic in Pen On The
Road help:

■ To view a size scale and its manufactured
sizes

To view inventory information:
This task helps you review the inventory data stored
in your pen computer, at two levels

■ Total cut information for a product

■ Units available by size within a cut

For specific instructions on viewing inventory
information, see the following topics in Pen On The
Road help:

■ To see the first level of inventory information

■ To see the second level of inventory
information
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To use Style Search to choose a 
product:
Pen On The Road’s Style Search feature helps you
build valid style numbers, that can be placed
automatically in a Style writing area.

Style Search is available both at the PRODUCT INQUIRY

window and at the ORDER window. Also, the STYLE

SEARCH dialog box appears automatically when you
write (or scan the bar code of) an unrecognized style
in a Style writing area.

Pen On The Road represents valid style numbers
according to how you set the search criteria. Search
criteria include division, gender, category, substyle,
color, and season codes.

For specific instructions on using Style Search to
choose a product, see the following topic in Pen On
The Road help:

■ To build a valid style number with Style
Search
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H
handwriting

entering information with your pen  22
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heading See order heading
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contents  7
exiting the help system  14
on a window  6
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other sources of  24
overview  25
printing a topic  13
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using  16

L
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lines See order lines
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M
Main Menu  3
menu bar  3, 18
menus  3, 18, 22
modem
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tips on using  46
troubleshooting  49

mouse
using  16

N
navigation buttons  3, 19 
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new orders
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O
operating system  27
order heading  31, 40
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activity of writing  40-41
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order search  30
order summary  35, 41
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showing and hiding  40
overview

help system  5-14
Pen On The Road  iii-iv, 29-37

P
pen

using  16, 21-23
pen computer  27
pen controls  22
pen edit menu  22
Pen On The Road  iii-iv
pen pointer  17
pen-editing button  22
pen-cursor button  22
pre-pack styles  40
prices  40
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product bar codes  See scanning
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R
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S
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scroll arrow  25
scroll bars

using 25
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searching for orders  30
sending orders  45-49
shipping address  40
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customer 41
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Size Next  42
sizing 32-34,40

viewing sizing information  53
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special instructions 40
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status, order  35, 41
store number  40
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pre-pack  40
reviewing inventory projections for 32-34
viewing product information about  53
writing, on order lines  40

Style Search  54
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symbols See feedback symbols
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